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It has become increasingly clear that neural circuit activity in behaving animals differs substantially from that seen in anesthetized or immobilized
animals. Highly sensitive, genetically encoded fluorescent reporters of Ca?" have revolutionized the recording of cell and synaptic activity using
non-invasive optical approaches in behaving animals. When combined with genetic and optogenetic techniques, the molecular mechanisms that
modulate cell and circuit activity during different behavior states can be identified.

Here we describe methods for ratiometric Ca2* imaging of single neurons in freely behaving Caenorhabditis elegans worms. We demonstrate a
simple mounting technique that gently overlays worms growing on a standard Nematode Growth Media (NGM) agar block with a glass coverslip,
permitting animals to be recorded at high-resolution during unrestricted movement and behavior. With this technique, we use the sensitive ca®
reporter GCaMP5 to record changes in intracellular ca” inthe serotonergic Hermaphrodite Specific Neurons (HSNs) as they drive egg-laying
behavior. By co-expressing mCherry, a Ca*"-insensitive fluorescent protein, we can track the position of the HSN within ~ 1 ym and correct for
fluctuations in fluorescence caused by changes in focus or movement. Simultaneous, infrared brightfield imaging allows for behavior recording
and animal tracking using a motorized stage. By integrating these microscopic techniques and data streams, we can record ca® activity in the
C. elegans egg-laying circuit as it progresses between inactive and active behavior states over tens of minutes.

Video Link

The video component of this article can be found at https://www.jove.com/video/56911/

Introduction

A central goal of neuroscience is to understand how neurons communicate in circuits to drive animal behavior. Neural circuits integrate a
range of diverse sensory cues in order to change circuit activity, thereby driving behavioral changes necessary for animals to respond to their
environments. The nematode, C. elegans, has a simple nervous system with 302 neurons whose synaptic connections have been completely
mapped1. Additionally, genes that encode for proteins involved in neurotransmission are highly conserved between C. elegans and mammals>.
Despite the anatomical simplicity of its nervous system, it displays a complex repertoire of conserved behaviors providing a fertile platform to
understand how neurons regulate behavior®.

C. elegans is amenable to the application of a wide range of approaches such as genetic manipulation, laser cell ablation, electrophysiological
techniques, as well as in vivo optical imaging4'5. Recent studies have produced detailed maps of the major neurotransmitter signaling systems
in C. elegans including the cholinergic and GABAergic neuronal networks. These studies, along with ongoing studies to map the expression
of all neuronal G-protein coupled receptors place this model in a unique position to leverage highly detailed structural and functional neuronal
connectivity maps to fully understand how these different neurotransmitters signal through different receptors and timescales to drive different
aspects of animal behavior.

In order to study dynamic neuronal activity patterns in any system, an essential prerequisite is to develop robust methodologies to record

activity in individual neurons or entire circuits during behaviors. Especially important is the amenability of such optical a;z)proaches to visualize

presynaptic activity that drives synaptic vesicle fusion. Fast and highly sensitive fluorescent reporters of intracellular Ca®*, along with the

increasing availability of sensitive photodetectors, have revolutionized the recording of cell and synaptic activity in awake, living animals during
. . . . P 2+ P 2+

behavior. Because a major outcome of synaptic electrical activity is to regulate Ca”" channels, changes in intracellular Ca“" are thought to

faithfully report behaviorally relevant changes in cell activity.

In this study, we present an approach to perform ratiometric ca? imaging in the serotonergic HSN motor neurons that promote egg-laying
behavior in C. elegansm. This approach builds on previous efforts to visualize ca*' activity in C. elegans and the egg-laying circuit during
behavior®®'%"" The method allows to simultaneously correlate the observed changes in cell/circuit activity with egg-laying events, as well as

Copyright © 2018 Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported February 2018 | 132 | e56911 | Page 1 of 10
License


https://www.jove.com
https://www.jove.com
https://www.jove.com
mailto:kevin.collins@miami.edu
https://www.jove.com/video/56911
http://dx.doi.org/10.3791/56911
https://www.jove.com/video/56911/

lee Journal of Visualized Experiments www.jove.com

changes in animal locomotor state. Although we use this approach to study activity in adult worms, unpublished work from our laboratory shows
this approach can be extended to juvenile animals at the fourth larval (L4) stage as well. It is likely that the activity of other C. elegans neurons
that function in distinct circuits and behaV|ors should be similarly acce35|ble with this technique. Other recently developed fast ca® |nd|cators
with non-overlapping emission spectra 213141516 , optogenetic tools'’, and genetically encoded optical indicators of membrane voltage should
allow us to perform penetrating 'all-optical' investigations into how changes in neural circuit activity drive distinct behavior states.

1. Strains, Culture Media, and Mounting of Animals

1. Grow C. elegans worms at 20 °C on standard 60-mm Nematode Growth Medium (NGM) agar plates seeded with OP50 E. coli bacterial
food®

2. Prepare two plasmids for each cell-specific promoter of interest: one, driving expression of GCaMP5 to record intracellular Ca®*, and the
second, driving expression of mCherry to allow for ratiometric quantitation of GCaMP5 fluorescence changes and simplify object finding and
measurement.

NOTE: GCaMP5:mCherry ratiometric imaging corrects for fluctuations in GCaMP5 fluorescence that result from changes in focus and animal
movement, not actual changes in intracellular ca*

3. Inject GCaMP5- and mCherry-expressing plasmlds along with the pL15EK visible rescue marker plasmid into the gonads of LX1832
lite- 1(ce314) lin-15(n765ts) X mutant animals and recover non-Muv /in-15(+) animals expressmg GCaMP5 and mCherry from a high-copy
transgene 202122 yse the lite-1 mutant background to reduce blue-light avoidance behavior

4. Integrate transgenes to chromosomes to reduce mosaicism and simplify the generation of compound mutant strains®®
NOTE: The LX2004 strain described here carrles an integrated high-copy transgene that expresses GCaMP5 and mCherry in the HSNs from
the nlp-3 promoter (see Table of Materlals) 6.21.28.29 Tpe nlp-3 promoter was found to drive strong expression in the HSNs of late L4 and
adult animals without causing significant defects in HSN development or egg-laying behavior compared to other promoters tested (e.g.,tph-1,
egl-6, and unc-86). This strain and others that express GCaMP5 and mCherry in the ventral cord (VC) motor neurons, vulval muscles, and
uv1 neuroendocrine cells are available from the Caenorhabditis Genetics Center and details of their construction have been described®”

5. Apply OP50 bacterial food from a seeded NGM agar plate to the bottom of a platinum worm pick, and use it to transfer ~ 20 late L4
LX2004 animals that express GCaMP5 and mCherry in the HSNs from the nip-3 promoter. Ensure that the developing vulva appears in a
stereomicroscope as a clear dark spot surrounded by a white crescent. Incubate animals at 20 °C for 24-40 h.

6. After the incubation, apply OP50 to the pick and transfer ~ 3 of the worms to an unseeded NGM plate, leaving a small amount of food behind
for the worms to feed upon during imaging. Ensure sufficient food, as too little bacterial food will encourage the worms to wander away from
the center of the plate while too much food will increase background fluorescence and cause hypoxia.

7. Use a flat rounded spatula to cut a ~ 20 mm x 20 mm chunk from the plate carrying the worms and transfer the chunk face-down onto the
center of a clean 24 mm x 60 mm #1.5 coverslip (Figure 1). Start the application from one side to keep bubbles from being trapped under the
coverslip and interfering with imaging. Apply a 22 mm x 22 mm #1 coverslip to the top of the chunk to reduce sticking and evaporation.

2. Hardware and Instrumentation Setup

1. Place the staged, transgenic worms onto the stage of an inverted microscope with a =2 0.7 Numerical Aperture Plan-Apochromat 20x
objective, motorized XY stage controllable with a joystick, an image splitter, and fluorescence filters for simultaneous GCaMP5 and mCherry
excitation and emission, cameras for fluorescence and infrared brightfield imaging, and a triggerable Light Emitting Diode (LED) illumination
system (Figure 2A).

NOTE: An 80/20 beam-splitter sends 80% of the image signal to the fluorescence camera and 20% to the brightfield camera. An upright
microscope can also be used, but the NGM chunk should be placed in between a glass slide and the large coverslip in this case.
1. Use the binocular eyepieces to select a worm for imaging. When an animal is selected, slide the infrared filter in place above the
condenser.

2. Transistor-transistor logic (TTL) triggers
1. Attach coaxial cables from each of the three TTL trigger output lines on the fluorescence camera. Connect the first output to the BNC
input #3 of the LED illumination system.
2. Connect the second output to a BNC 'banana’ adapter with green and brown wires from the 8-pin GPIO connector running to GPIO
input #3 (pin 4) and ground (pin 5) of the infrared camera, respectively.
3. Connect the third output to a BNC 'banana' adapter with jumper wires running to the #8 digital input and ground in the digital acquisition
device (Figure 2B).

3. Digital acquisition device (DAQ)
1. Connect the DAQ microcontroller board (see Table of Materials) to the PC via a USB cable. Update the firmware with the standard
Firmata protocol (see Table of Materials) and configure the USB port to communicate at 57600 baud.

4. LEDs
1. Run the LED Controller software (see Table of Materials). Switch the Trigger Mode from 'Continuous' to 'Gated' and select Trigger
Channel '3’ for both the 470 and 590 nm LEDs.
2. Turn on and enter LED power for each LED (e.g., set the 470 nm LED to 20% and the 590 nm LED to 40%).

5. Run the serial-stage communication script 'XY-stage-final' in Bonsai (see Table of Materials)ao. Click on the grey 'CsvWriter' node and select
a folder to save the recorded X and Y stage information (Figure 3). Press the green arrowhead in the toolbar to initialize the DAQ.
NOTE: The script will start recording the X and Y stage position when the fluorescence camera sends a TTL signal. This script outputs four
columns of data: frame number, X position (um), Y position (um), and the interval between frames (s).
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6.

In the infrared camera recording software (see Table of Materials) under 'Custom Video Modes,' select "Mode 1" (2 x 2 binning; 1,024 x
1,024 pixels), and "Pixel Format Raw 8". Under 'Trigger / Strobe', set the trigger input line (GPIO) to "3", the polarity to "High", the 'Mode' to
"14". Toggle 'Enable’ to stop frame acquisition until a TTL trigger signal is received.
1. Leaving that window open, click the red "Record" button on the main camera view toolbar. Select the folder for image sequences to be
saved. Select '‘Buffered' Recording mode, and save 'Images' in JPEG format. Click "Start Recording" to initialize the acquisition.

Fluorescence camera and image splitter
NOTE: GCaMP5 and mCherry fluorescence channels must be collected simultaneously to ensure proper image registration for ratiometric
quantitation. An image splitter allows two-channel acquisition of the GCaMP5 and mCherry fluorescence onto one sensor.

1. In the 'Capture’ tab of the image acquisition software (see Table of Materials), set exposure time to 10 ms, binning to 4x, and image
depth to 16-bit. Select a centered camera subarray of 512 pixels wide by 256 pixels high. Click 'Show Output Trigger Options' and set
all Triggers to 'Positive.'

NOTE: The DAQ can occasionally miss TTL triggers if they are 10 ms or less.

2. Ensure that 'Trigger 1' and 'Trigger 2' are set to 'Exposure’ while 'Trigger 3' is set to 'Programmable’ with a 'Period’ of 25 ms. Under the

'Sequence' tab, select 'Time Lapse' with a 'Field Delay1' of 50 ms to collect images at 20 Hz. Select 'Save to Temporary Buffer.'

PMT gain and laser intensity during three channel confocal imaging
1. Set the PMT gain so the background fluorescence is at a level just above the minimum (black level). Increase 561 nm (green) laser
power until a single saturated 12-bit or 16-bit pixel is observed at the presynaptic terminus in the mCherry channel.
2. Adjust 488 nm (blue) laser intensity so that GCaMP5 fluorescence is just visible at the presynaptic terminus above background. This
low setting prevents the saturation of the GCaMP5 pixels when the fluorescence increases in response to strong Ca®" transients. Open
the confocal pinhole all the way to maximize light capture.

3. Ratiometric Ca** Imaging and Behavior Recording

2.

Under the 'Sequence’ tab in the fluorescence acquisition software, click "Start" to begin recording. Track the worm with the joystick, keeping
the cell(s) and synapses of interest in focus and in the center of the field of view (FOV). Click the 'Stats' button in the histogram window to
show pixel statistics of each channel.

Adjust the LED power to ensure a maximum single-pixel mCherry fluorescence at the presynaptic terminus of = 8,000 counts (~ 4,000
photoelectrons), giving a ~ 12-bit dynamic range above background (~ 100 photoelectrons). GCaMP5 signals at the presynaptic terminus
during resting (low) Ca?" should be around ~ 2,500 counts - just visible above background.

Record until one egg-laying active state is reached; typically this occurs every 20-30 min in a wild-type worm’. Save a 10-min subset (12,001
frames), 6,000 frames before and after the first egg-laying event (frame 6,001). Be sure to keep the same subset of brightfield images of
worm behavior and timepoints of XY stage position, or the precise synchronization of data streams will be lost.

Use Imaged and the BioFormats plugin (see Table of Materials) to convert image sequences to Image Cytometry Standard (.ics) format so
that it can be imported into the Ratiometric Quantitation software.

4. Image Segmentation and Quantitative Analysis

Import image sequences into the Ratiometric Quantitation software (see Table of Materials). Click 'Auto Contrast' in the "Tools' menu, and
adjust contrast of each channel to establish appropriate black (~ 1,800) and white levels (10,000). Select 'Change Colors..." in the Tools menu
to confirm that mCherry and GCaMP5 channel color assignments are correct (Figure 4A - C).

1. Right click on the Time Series in the 'Sequence' tab and set it to 20 frames/s and 1.25 pm/pixel.

2. Select 'Ratio’ from the "Tools' menu and select "GCaMP5" for 'Channel A' and "mCherry" for 'Channel B'. Click "Calculate" next to 'Threshold'
to subtract the background from each image sequence. Select "Apply a rainbow LUT to the ratio channel".

NOTE: For a recording with a mean baseline ratio of 0.3 (low Ca2+) and a max ratio of 2-3 (high Caz+), a suitable lookup table would be from
0 (blue) to 1 (red).

3. Generate an Intensity Modulated Ratio channel using the mCherry channel (Figure 4D). The Intensity Modulated Ratio channel is a millions-
of-colors image where the ratio color is mapped onto the brightness of the mCherry channel.

4. Under the 'Measurements' tab, create an object-finding protocol by dragging the 'Find Objects Using Intensity' tool to the 'Protocol’ pane.
Click the 'cog' to set the window of mCherry intensity values and find objects.

1. Select intensity values = 2 standard deviations (SD) above background (e.g., lower limit of ~ 2,500, upper limit of 65,535). Make sure
the presynaptic terminus is detected and that 'automatically update feedback' is selected from the Measurements menu.
NOTE: The software can also identify objects by their standard deviation from background using a related protocol 'SD Intensity.'
However, if an especially bright object enters the FOV, it can dramatically change the mean intensity during those timepoints, affecting
the intensity cutoffs used to find the HSN. This variability will not occur if raw intensity values are used to find objects.

5. Add additional filters targeting only the mCherry channel (size, Max intensity, efc.) if necessary to exclude undesired objects like head, tail,
and gut fluorescence. Select 'Make Measurement Item' from the Measurements menu and choose 'All Timepoints.'

NOTE: This will execute the protocol, writing all measurements to a comma-separated value (.csv) file that should be exported using the
‘export' command in the File menu.

6. Open exported.csv file and copy Timepoint, Area (pmz), Mean (Ratio Channel), Centroid X (um), and Centroid Y (um) data into a new sheet.
Export a.csv file without column headers. The Ratiometric Quantitation software may classify a cell of interest as one or more objects per
timepoint.

1. To recombine these objects, use a custom script 'AnalzyeGCaMP_2017.m'".
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NOTE: The script also identifies ca®* (ratio) peaks in the data, and saves a.csv file of their timepoints, peak amplitudes, and peak
widths. It also generates postscript files for the raw and annotated ratio traces. With this information, Ca®" transient amplitude and inter-
transient interval should be determined.

7. Add the output X and Y centroid values from each fluorescence object to the X and Y values recorded by the XY-stage script from Bonsai.
Use the net XYSposmon to generate a worm locomotion trace and to calculate cell displacement and velocity that accompany different
behavior states

8. Import the recorded brlghtfleld images into ImageJ as a virtual stack. Annotate egg-laying events and other behaviors. Compare the timing of
these events to Ca® * peaks from the ratio trace.

Representative Results

The simple mounting technique described here (Figure 1) causes minimal changes to the culture environment of L4 and adult C. elegans

while allowing high resolution recording in behaving animals through a glass coverslip (Figure 4). Synchronization of LED light sources, stage
controllers, and camera exposures allows for data acquisition from multiple streams at 20 frames/s for up to 1 h. Intermediate magnification
(20x) with high numerical aperture objectives (0.7-0.8) provides good spatial resolution of the synaptic region in the egg-laying behavior circuit,
even with 4 x 4 pixel binning (1.25 um/pixel). Simultaneous acquisition of GCaMP5 and mCherry fluorescence signals (Figure 4A, B) is used

to generate a pixel-by-pixel ratio channel that compensates for changes in animal movement and focus (Figure 4D). The HSN presynaptic
terminus is as large as many neuronal cell bodies in C. elegans, and changes in presynaptic HSN Ca?* can be clearly visualized. The large FOV
of the infrared brightfield camera allows the worm to be manually tracked during recording (Figure 4E). For each animal, changes in intracellular
Ca?* can be correlated with behaviors evident in brightfield imaging including egg release and changes in locomotion (Figure 4E).

Quantitation of HSN Ca®* and speed confirms that worms change their locomotion as they transition to egg-laying behavior. There are significant
differences in worm speed before, during, and after the egg-laying active state (Figure 5A). This is not caused by noise inherent to the imaging
or tracking system. Zooming into one egg-laying event, we observe a strong change in GCaMP5 fluorescence (AF/F) prior to the egg-laying
event while mCherry fluorescence is relatively unchanged (Figure 5B). Measured changes in the GCaMP5:mCherry ratio (AR/R) clearly show
an HSN Ca®" transient ~ 4 s prior to egg release (Figure 5B). Coincident with vulval muscle contraction, a clear slowing of worm locomotion
occurs that ends with egg release. Previous results have shown that the chollnerglc VVC motor neurons, which are innervated by the HSNs, show
peak activity during strong vulval muscle contractions and during egg release 81027 \We have also shown that optogenetic activation of the VC
neurons drives an immediate slowing of locomotion, suggesting that the VC neurons may be activated by vulval muscle contraction, thereby
slowing locomotion until receiving feedback of egg release”’.

The imaging and tracking system described allows visualization of the spatial organization of egg-laying behavior (Figure 5C). As previously
shown, worms enter sustained runs of forward locomotion just prior to the active state®®. Worms spend the majority of their time foraging on
bacteria at the center of the agar chunk Prior to entry into the active state, worms move away from the food, which is coincident W|th the
appearance of infrequent HSN Ca®" transients. HSN activity then transitions into burst firing, with several closely spaced HSN Ca®! transients
that sustain egg-laying events. The worms then often turn around, resume forward locomotion, and lay eggs on the way back toward their
starting position near the OP50 bacteria. We presume that changes in local O, and/or CO, concentration may be influencing where the worms
decide to lay eggs

small amount of
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with worms = NGM plate
V\ 4
(900 \ & / 24x60 mm #1.5
\ L
\' wWarms
‘7

)

. eggs

Figure 1. C. elegans mounting technique for high-resolution imaging of egg-laying circuit activity and behavior. Top, the final mount from
the side. Bottom, the final mount as viewed through the bottom of the large coverslip. Arrows indicate OP50 bacterial food, C. elegans worms
and eggs, sandwiched between the NGM agar chunk and the large 24 mm x 60 mm coverslip. Please click here to view a larger version of this
figure.
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Figure 2. Widefield ratiometric ca® imaging and behavior recording on an inverted epifluorescence microscope. (A) Worm position

and behavior is captured in brightfield via a 20x (0.8 NA) Plan-Apochromat objective using infrared (750-790 nm) light (purple arrows) emitted
from a halogen lamp through the NGM chunk. A joystick and motorized stage controller is used to maintain the worm in the field of view during
recording. Stage position (Ax, Ay) is sent to the PC by the serial port. GCaMP5 and mCherry proteins expressed in the worm are excited using
470 nm (blue arrows) and 590 nm (yellow arrows) Light Emitting Diodes (LED). Emitted GCaMP5 (green arrows) and mCherry (orange arrows)
fluorescence along with the infrared light passes through a multi-band dichroic mirror (see Table of Materials). An 80/20 beam-splitter sends
20% of the light through a 0.63x demagpnifer for capture on an infrared-sensitive CMOS camera (purple arrow). The remaining 80% of the light is
sent through the side-port of the microscope to an image splitter that separates the GCaMP5 and mCherry fluorescence onto separate halves of
an sCMOS camera while removing infrared brightfield light. Data from both cameras are transferred to a PC via USB3 cables. The trigger ports
from the fluorescence sCMOS camera (blue) are used to send +5V TTL triggers to the LED illumination system, the infrared brightfield CMOS
camera, and the Digital Acquisition Device (DAQ). (B) Trigger 3 output TTL signals are detected by the DAQ at digital pin #8 and sent to the PC
through a USB connection. These digital inputs trigger a 'where XY' serial command from a Bonsai software script (XY-stage-final) which reads
the X and Y stage position for each GCaMP5/mCherry fluorescence/infrared image captured. Please click here to view a larger version of this
figure.
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Figure 3: Layout of the Bonsai serial-stage communication script XY-stage-final. The top Digitallnput node (pink) reads TTL triggers
coming into pin #8 of the DAQ. For each positive TTL voltage (green), the DAQ makes a timestamp (blue) and writes a "Where XY?' string
(pink) to the stage controller via the serial port (grey). The SerialStringRead node (pink) reads the X and Y coordinate response from the

stage controller. This string is then converted into microns and separated into X and Y stage coordinates. Finally, these four streams are
combined using a zip node (blue) and a four column.csv file is written: a frame count of the TTL signals received (Range node, pink), the X and
Y coordinates, and the interval between subsequent timepoints (typically ~ 50 ms when recording at 20 Hz). Please click here to view a larger
version of this figure.
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Mid-body fluorescence (two channel) Whole animal bright-field (infrared)

Figure 4: Representative micrographs of HSN fluorescence and whole animal brightfield during egg-laying behavior. (A-D)
Simultaneous ratiometric imaging of GCaMP5 and mCherry fluorescence in the HSNs just prior to egg release. HSN presynaptic termini are
indicated with arrowheads. (Cg Merge of GCaMP5 and mCherry fluorescence. (D) Intensity-modulated GCaMP5:mCherry ratio; a high ratio (red)
indicates high intracellular Ca* at the presynaptic terminus. (E) Brightfield image of the entire worm just after eggs have been laid. Arrowheads
indicate the anterior and posterior halves of the vulva from which eggs are laid. Scale bar for all images is 50 um. Please click here to view a
larger version of this figure.
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Figure 5: Recording of HSN Ca* and locomotion speed during egg-laying behavior. (A) Traces of GCaMP5:mCherry ratio changes in
response to intracellular Ca*" transients (AR/R; red) along with instantaneous worm speed (um/s; blue). Egg-laying events are indicated by
arrowheads. (B) Traces of HSN GCaMP5 fluorescence (green; AF/F), mCherry fluorescence (red; AF/F), GCaMP5:mCherry fluorescence ratio
(black; AR/R), and worm speed (blue) around the moment of egg release. (C) Spatial organization of egg-laying and locomotion behaviors during
the entire 10-min recording. The worm track was obtained from the XY stage information which was added to the centroid position of the HSN
obtained from the mCherry fluorescence recording. The timing of HSN transients (red circles), egg-laying events (black arrowheads), and the
start and end of the recording (green and blue diamonds) are indicated. Scale bar is 1 mm. Please click here to view a larger version of this
figure.

Transgenes:

Because mCherry expression has been improved through codon-optimization and intron insertion (and most available GCaMP reporters

have not), inject ~ 4x the amount of GCaMP5-expressing plasmid to ensure comparable levels of GCaMP5 fluorescence during strong ca®
transients. Rescue of the lin-15(n765ts) mutation allows for the facile recovery of transgenic animals with minimal effects on e%g-laying and other
behaviors®. Transgenes should be integrated to ensure uniform expression and imaginag conditions between different animals®”. Selectable
markers including antibiotic resistance®*” and rescue of temperature-sensitive lethals® should also work, but, because non-transgenic animals
are dead, confirmation of transgene integration and homozygosity is more difficult compared to markers that present a visible phenotypezs.
Dominant markers that disrupt normal locomotion and decrease fitness, such as rol-6(dm), should be avoided*®. Imaging in the lite-1 mutant
background is essential to reduce blue light escape responses during imagingzs"w'“. Additional mutation of gur-3, which acts in parallel to lite-1,
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may further minimize residual behavior and physiological changes caused by blue Iight42. Conveniently, gur-3, lite-1, and lin-15 are all situated on
the right half of chromosome X, which should simplify the construction of new strains for ca® imaging and optogenetic experiments.

Because exposure times are short and images are collected at 20 Hz, GCaMP5 and mCherry signals must be bright. The most likely explanation
for noisy ca® recordings is dim fluorescence caused by weak reporter expression. Promoters should also be reasonably specific for the region
being imaged. Because the HSN cell body and synapses onto the vulval muscles are in the center of the body, additional expression from the
nip-3 promoter in the head and tail is typically outside the field of view and can be excluded using additional filters in the Ratiometric Quantitation
software. To ensure that observed changes in GCaMP5 fluorescence result from actual changes in intracellular Ca?*, control transgenes
expressing GFP instead of GCaMP5 should be independently prepared and analyzedzs. Newer Ca** reporters with different Ca?" sensitivities,
kinetics, and colors have expanded the choice of imaging tools available, but each new reporter should be validated using the Ca?"-insensitive
fluorescent variant'*®.

Media:

NGM plates for imaging should be prepared with high quality agar. Lower quality agar will not completely dissolve upon autoclaving, leaving
small particulates that scatter light during imaging, and increasing background fluorescence. Molecular biology grade agarose can be used
instead, but the amount added should be reduced to maintain equivalent plate firmness.

Comparisons to Other Mounting Methods:

Previous approaches to image activity in the egg-laying behavior circuit have used worms immobilized with glue to an a%arose pad. Under
these conditions, circuit activity and egg-laying behavior is not favored without a reduction in culture media osmolarityB’1 #4445 Recent evidence
suggests that several worm behaviors are modulated by locomotion state, raising questions about the relationship of cell activity observed in
immobilized animals to that seen in freely behaving animals. We have recently shown that egg-laying circuit activity is unexpectedly phased with
locomotion?®%. Similarly, compartmentalized ca® signaling in the RIA interneuron integrates activity from sensory neurons and head motor
neurons during foraging movements*®. Defecation behavior is also accompanied by a precise and stereotypical change in locomotion that allows
animals to move away from their foraging spot before expelling waste*’. Together, these results suggest that brief recordings of circuit activity
from immobilized animals may be fundamentally different from those obtained in freely behaving animals.

Despite being directly beneath a coverslip, the worm's behavior resembles that seen on standard NGM plates. Laid eggs will go on to hatch, and
the small amount of food deposited allows the L1 larvae to grow into adults (data not shown). The large agar chunk size allows for reasonable
gas exchange and resists dehydration, although too much food will increase background fluorescence. While this method works best for adults,
the technique can also be used to image L4 animals. However, the thickness of the aqueous layer between the chunk and the coverslip is such
that smaller larvae have difficulty crawling, and can often get trapped in the wake of a moving adult.

A limitation of this mounting technique is that direct mechanical or chemical stimulation to precise regions of the body is difficult. Recent
developments in patterned illumination techniques allow for the separate excitation of head or tail-expressed microbial opsins with separate
illumination and detection of GCaMP/mCherry fluorescence in the midbody48’49. As a result, it may be possible to overcome this issue using
optogenetic approaches.

Comparisons to Other ca* Imaging Approaches:

This method works very well for recording changes in cytoplasmic Ca® from single, resolved cells and their synaptic regions. Real-time,
volumetric imaging of neurons in the head has recently been achieved using the position of cell nuclei for cell identification and to quantitate
changes in nucleoplasmic calcium®°"2 The relationship between nuclear and synaptic Ca® remains unclear. Our data suggest the most
conspicuous changes in HSN intracellular Ca?* occur at the presynaptic termini away from the cell soma (Figure 4D). The presynaptic termini
of the HSN and the VC neurons are embedded in the postsynaptic vulval muscles®®. It is not clear whether there would be sufficient resolution
in the Z dimension even with spinning disk or light sheet techniques to ascribe presynaptic ca* signals to specific cells without relying in some
way on somatic calcium for cell identification. Using the techniques described here, each 10 min, two-channel recording with 12,001 256 x 256
16-bit pixel TIFF images is ~ 4 GB. The ratio and intensity modulated ratio channels double the file size to ~ 8 GB. A typical experiment recording
10 animals from each of two genotypes (wild-type and experimental) generates nearly 150 GB of primary data and requires 20 h to collect and
analyze. Volumetric analyses with 10 Z slices per timepoint would require an order of magnitude more data and analytical time, explaining why
so few such studies have been completed.

Hardware:

We record and analyze image sequences on dual processor workstations with high-performance (e.g., gaming) graphics cards, 64 GB of RAM,
and high performance solid-state drives (see Table of Materials). Data should be stored on networked redundant array of independent disks
(RAID) and backed up to the cloud at an off-site data center.

We recommend using high-power collimated LEDs for pulsed fluorescence excitation over metal halide or mercury-based light sources. Several
commercially available multi-color LED systems are available. While some of these LED systems have a higher upfront cost, they have a long-
life (> 20,000 h), can simultaneously excite four or more different fluorophores, and offer precise temporal control using a serial and/or TTL
interface with low latency (10-300 ps switch time). Triggering ensures that the sample is only illuminated when data are actually being collected.
We typic?ally use a 10 ms exposure every 50 ms (20% duty rate). This reduces phototoxicity and motion blur during image capture, as previously
reported ™.

We use sCMOS cameras for their speed and large array of small, sensitive pixels. An EM-CCD camera is a more expensive alternative,

but 'bloom’ effects can result in captured photoelectrons spilling into adjacent pixels. New back-illuminated sCMOS cameras have similar
photosensitivity of EM-CCDs at significantly reduced cost. Regardless which sensor is used, the GCaMP5 and mCherry channels must be
obtained simultaneously. Sequential capture in moving worms will lead to poorly registered images unsuitable for ratiometric quantitation. Dual
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channel imaging can be accomplished onto a single camera after splitting of channels using an image splitter (Figure 2) or using two identical
cameras. The dynamic range of 16-bit images is recommended over 8-bit images for accurate ratiometric quantitation. For brightfield images of
worm behavior, we capture using a 1 in. 4.1 MP near-infrared USB3 camera to capture large 2 x 2 binned 1,024 x 1,024 8-bit image sequences
after JPEG compression. The larger FOV available on newer microscope models allows an adult worm to be visualized at 20x after 0.63x
demagnification with only slight vignetting (Figure 4E).

We recommend using standard TTL voltage signals to synchronize illumination and frame capture. Because of potential latencies in different
software programs, we recommend users configure the fluorescence camera with trigger outputs as master with TTL outputs driving all other
devices. In this way, brightfield and stage position information will be collected for each Ca?* measurement.

Slit- or resonant point-scanning confocal microscopes typically found in shared confocal facilities also give excellent performance during
ratiometric Ca* imaging. Such instruments can be used to capture two or more fluorescence channels along with brightﬁeld24. In this case,
the confocal pinhole should be opened to its maximum diameter, and a spectral detector should be used to separate GCaMP5, mCherry, and
infrared brightfield signals. This maximizes light collection from a thick (~ 20 um) slice while still allowing rejection of out-of-focus fluorescence.
One downside is the smaller FOV and more restrictions for hardware and software customization.

Software:

Most manufacturers ship and install their cameras and microscopes with proprietary software, including configuration of triggering inputs and
outputs. The features and performance of this software during recording can vary. Because fast moving worms can be challenging to track,
image display during recording needs to be smooth and stable at 20 Hz. To improve performance, image sequences can be temporarily saved
in RAM with behaviorally relevant subsets saved at the end of the experiment. These two-channel image sequence files can be converted to
the open Image Cytometry Standard format (.ics) for import into the Ratiometric Quantitation software. OME-TIFF is a more recent open-source
image format, although different installations may be unable to save TIFF image sequences greater than 4 GB.

A key feature of the quantitation pipeline is the generation of the ratio channel and then an unbiased image segmentation procedure using
mCherry fluorescence to find cells of interest. From each found object, the object size, XY centroid position, and the minimum, mean, and
maximum fluorescence intensity values for each channel (including the ratio channel) are calculated. Together, these values are used to
quantitate changes in intracellular Ca®* at each timepoint in the recording. Object measurements for each timepoint are then exported as a.csv
file for subsequent analyses.

A major limitation of the protocol described here is the dependence on moving the data in different forms through a patchwork of software
products. An additional irritation is that some of the software is open-source and free while others are closed, expensive, and unevenly updated.
A major improvement would be to use or develop one piece of software (ideally open-source) that provides similar levels of performance and
ease-of-use from acquisition to analysis. As noted above, ratiometric analysis doubles both the file size and time required to complete an
experiment. Generation of camera drivers that can be integrated into user-customizable frameworks like Bonsai would allow images and other
data streams to be collected and analyzed in real-time, significantly improving throughput.

Future Prospects:

While we typically track worm movements manually, tracking of the worm centroid detected in infrared bright- or dark-field recordings should
allow for additional image processing nodes that provide closed-loop adjustment of stage position and automated tracking (Figure 3 and data
not shown). The majority of the fluorescence recordings obtained with this method is dark and devoid of biologically interesting data. On-sensor
or real-time post-acquisition image processing techniques that crop image sequences to relevant objects would allow for increased spatial
resolution and expedite the data analysis pipeline, particularly if additional Z-slices are collected for each timepoint to visualize activity within all
pre- and postsynaptic cells in the circuit.
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